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ne of the projects we listed for things for locked down

photographers to do was to learn fine art printing. This has

the same basic approach as any other photographic printing

except that when it comes to reproduction and limited-
edition printing, a higher level of control is required. The first thing to
emphasise is that it is relatively hard to make a living from fine art print
sales, very few manage it. But this is also true of professional photography
in general - it too is also difficult to make a serious living at and many fail
to do so but having said that the talented rise above the crowd. The fine
art print has more market penetration in the USA where, traditionally,
more limited edition prints and originals are purchased to hang in homes
than the UK. Some parts of UK have yet to progress beyond the Chinese
Girl, copies of which are still occasionally seen in chip shops*. Undaunted
we continue our mission to get more quality prints out there. We should
say at the outset that the original germ of the idea was planted by Christy
Lee Rogers when we saw her venture to publish one of her fabulous
prints as a limited-edition and donate the proceeds to Save the Children
and No Kid Hungry (see opposite). Such a worthy cause and such a fine
photographer, we wish her every success with the venture. Do visit her
website, it is rich with fabulous images and a really interesting BTS film
of her working.

The world of the print is a bit like life — it covers a wide range of
characteristics. At the top end a Pablo Picasso print (The Frugal Repast)
sold for £1,945,250 in 2012 and a Toulouse-Lautrec reached $12,485,000.
These are very much the cream on top of the milk and some distance
from the realities of the average photographer. It is also important to be
realistic about the differences and values of the various print technologies.
Ink jet printing, even though its fidelity far outweighs anything that artist
can do suffers from its ability to produce at limitless capacity. A classic
lithograph is technically limited in its print run because it suffers wear
after every impression until the block (and its waxed image) is spent - the
purchaser of such a print has the certain knowledge that not a single
print more can come into existence once the plate is finished with. This
is not a guarantee that can be attached to a digital print and this reflects
in the value. The best that the print buyer can hope for is the good-will
and reputation of the artist. Even this has caveats, for if the edition has
a limit of say 250 prints but they are ‘printed on demand’ the digital file
could be in existence long after only a fraction of the edition was sold
and indeed sales had dried up. This is a good reason to strictly limit the
edition size, if only five are to be made then all can be printed in the same
run and the job is finished. The dilemma then exists for the creator — do |
keep an archive of the file or delete it? This is a philosophical argument;
traditionally the Artist Print is made outside of the print run and signed AP
to differentiate it from the edition and retained by the artist (but is this the
same as keeping the digital original? — personally | doubt it!).

The way around some of these dilemmas is to restrict your output to
prints that are bought purely because they are attractive (certainly to
the purchaser) which is why any gallery will tell you that prints of scenes
local to the gallery sell well, followed by scenes that the purchaser is likely
to be familiar with (eg Venice - ‘It's where we had our honeymoon'’ sort

*

What goes around and all that - in 2013 the original
Vladimir Tretchikoff portrait Chinese Girl, often referred
to as The Green Lady, was sold for almost £1m ($1.5m) at

auction in London. The model, Monika Pon-su-san was
painted by the artist after he saw her in her uncle’s laundry
in Cape Town in 1950. She was paid £6 10/- (younger
readers ask you grandparents what that is).

Imagemaker
e

[av2)

=)
N
{1‘
S
=3
=)
I~

Fine Art Printing

Introducing the Lockdown Locker

Note this feature was electronically published ahead of ink on paper
printing as part of The Societies’ quest to keep our members busy and
engaged during the Corona Virus lock down. We have also provided
additional material in the Lockdown Locker to keep you all out of
mischief! https://thesocieties.net/lockdown-locker/

of thing!). You may have a burning ambition to satirise Trump but that
is unlikely to keep the wolf from the door (although a print on the door
might!). It probably explains also why monochrome, silver halide prints
of naked women are the top sellers at auction. This tactic of selling what
is attractive to the purchaser is also reflected in images of cartoon cows,
meerkats and hares which always sell well. The message then is that you
should create art that has appeal - general appeal!

If you examine the photographer’s skill set and assign value to it then the
ability to both reproduce and print limited editions is high up the list. As
photographers we have the skills to scan or photograph originals, colour
correct them, and colour manage the print workflow for high-grade
output. If you have an ink jet printer available for say wall portrait printing
then it is likely to have quite a lot of idle time which can be picked up by
printing for artists. To differentiate yourself from any other outlet your
best weapon is quality — provable quality. This comes from the availability
of superb colour management tools that are now available at desktop/
home studio level. My own experience with many framing specialists who
have an old ink jet in the corner is generally poor. The colour management
skills are generally absent, they think little of using any old ink set and the
cheapest paper they can lay their hands on. Some of the results | have
witnessed almost beggar belief - trust me there is not always much to
beat out there.

The limited edition process breaks down into the following activities:
Scanning and photography

Detailed colour correction and file preparation

Paper Choice and print size decisions

Colour managed printing and auditing

Decision on edition size

Certificates of Authenticity

Signing and stamping

Keeping records

Print on demand issues

WONOULTAWN =

Scanning and Photography

f the art is a digitally created file from a camera, a painting program
such as Corel Painter, or a Photoshop creation (either montage or
painted) then this stage can be skipped.

There is a slight possibility that a transparency or colour negative will
be provided. If so, proceed with extreme caution! Despite claims by
some dinosaurs that film is better than digital (yes, they are still at large)
nothing could be further from the truth. However, it might be all that is
available, in which case explain the pitfalls and limitations of the process
and agree how you are going to proceed, and how the venture is to be
costed and paid for. It is likely to take you twice as long as you expect!
These remarks do not apply if the ultimate piece of art is a hand-made
platinum print; they are to some extent the gold standard (platinum or
palladium standard in fact) including when they are made by contact
printing a digital negative. They are today'’s iteration of one of the oldest
photographic printing methods.

If you have artwork, things are a little easier as you have a standard
against which to judge your final reproduction. First though you have
to decide between scanning and camera reproduction. Either way the
artwork has to be removed from its frame - essential for scanning, but
just about negotiable for camera repro. If there is glass in front of the
artwork and it cannot be dismounted, then all bets are off and you have to
negotiate on a best endeavours basis. At this point it should be noted that
you need ‘goods in trust insurance’ for the time the art is in your custody
- either against damage or theft. Only experts should dismount valuable
artwork from its frame anyway.




Christy Lee Rogers
Venus Risin g

Dedicated to the young victims of Corona Virus

Save The Children and No Kid Hungry Charities

DONATE TODAY AND BUY VENUS RISING Christy Lee Rogers is an International underwater artist from Hawaii
https://www.christyleerogers.com/ who last year was selected as Open Photographer of the Year for the
Sony World Photography Awards. She was commissioned by Apple to
Editions and Sizes of Venus Rising make a series of photographs using the iPhone 11Pro and Apple made
21 x 30" (53 x 76cm) Edition of 200 Paper $1,111 a behind-the-scenes process film about her. The Independent of London
28 x40” (71x101.5cm)  Edition of 100 Paper $1,555 compared her underwater photography to the works of Caravaggio,
Delacroix, Rubens and Titian. And CNN had this to say about her works
All prints are made on Hahnemiihle 100% cotton 315 gsm watercolor "Rogers is changing the way water is used in photography to create
museum quality paper. Rolled and packed in an extra sturdy tube. images that can easily be mistaken for paintings and that push the
Shipping will take place within 3-6 weeks, or as postal services are boundaries of reality."

available and open. Your print will come signed on the back with a
special Corona virus note from Christy.
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Fine Art Printing

Scanning

Flatbed scanning is preferable for a water colour or any other ‘flat’ artwork
such as pencil, crayon, pastel or smooth acrylic. Even so you should seek
permission to lay the artwork onto your scanner platen before you start.
The chances of an image fitting onto an A4 flatbed scanner are not high
but it is easy to perform multiple scans and montage the results into a
single file. We have successfully done this with 12 images, although it is
useful to be able to remove the scanner cover to do this. Also make sure
you have a clear working area that is spotlessly clean and if your scanner is
sunken level with the work surface so much the better. Important pointers
are that the scanner colour corrections should be turned off so that all
the scans are graded identically and then for best practice a scanner
calibration profile assigned to the assembled file. Scan at your highest
bit-depth and about twice the resolution you need in the final image. Turn
all the auto features such as sharpening and dust removal off. Aim for at
least an inch of overlap between scans if you are montaging. When all the
scans are complete and, if necessary, rotated by 180°, from Adobe Bridge
click Tools>Photoshop>Assemble Files into Photoshop Layers. Then from
within Photoshop click on all the layers in the Layers Palette then click
Edit>Auto-align Layers and hopefully the job will montage correctly.
Manually adjust the positioning if required then check very carefully for
any residual mismatches. Then Click Edit>Auto Blend Layers, make one
final check and then flatten the image and save it as ‘uncorrected master’
Assign your scanner profile (see box out) and then convert to profile with
an output target of either ProPhoto RGB or AdobeRGB (if you have more
than say eights inks on your printer, you might benefit from the extra
gamut by using ProPhoto RGB otherwise Adobe RGB is fine - avoid SRGB
with its slightly low gamut volume).

At this stage you may need some final tweaks to the levels of the image,
especially for watercolours for the following reason. If your file is close
to a perfect reproduction and the original watercolour is on a creamy,
off-white paper then this will be reflected in the scanned file - the paper-
white parts of the painting, the highlights, should be creamy too. Now if
you eventually print onto a creamy art paper then you have the cream of
the file added to the cream of the paper, which could be too much. If this

An 8-up scan of Liverpool artist John Christianson's
original watercolour. This job was particularly tricky
because there were few good lines for the software to
grab onto when montaging.

is the case use levels and pull the highlights (right-hand slider) in enough
to bring the highlights to 255 so that no ink is put down by the printing
and the ink jet paper provides the correct cream tonal value to that part of
the reproduction. Experience has also taught us that, when offered a little
more contrast (by pulling the shadow slider of levels inboard a tad), the
artist will prefer this. Of course, if you are reproducing your own work you
can do what you like! We will cover any residual errors later.
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Camera Reproduction

Camera reproduction may be essential if the original contains heavy
brushwork (impasto) even worse if it has been executed with a palette
knife. Vertical camera stands are available for the task, although they
might be insufficiently tall to take in a large image in which case a four-up
montage might be required. If that fails, then setting up the original on a
wall and shooting from a tripod is the best option but bear in mind that
alignment is critical and set up can take quite a long time. We will talk
about residual geometric corrections later.

The camera should be set to manual exposure, manual white balance
and manual focus (we often tape the lens barrel to prevent movement
of the focus). The exposure should be optimised with a grey card or,
even better, by using a Macbeth SG Chart and a tethered set-up so the
exposure can be doubled checked in ACR. Shoot Raw at the highest
resolution the camera is capable of (normally its lowest I1SO, but check).
If you are intending to enlarge the print compared with the original do
the sums to ensure that you have enough resolution (although in our
experience paintings are more forgiving as the fine detail is relative coarse
in comparison to photographic resolutions). Shoot a Macbeth chart at
either end of the sequence and use this to perform a calibration that
can be applied to the Raw files. Within Raw, apply chromatic aberration
correction. The lens should preferably by a specialist manual macro lens
which is better corrected (the ‘drawing’ of the lens as it is known). Using
a zoom lens be sure to apply the lens profile in ACR to correct geometric
distortion. Montages from zoom lenses are likely to fail due to geometric
distortion although you should be OK with a single shot.

From the Macbeth target image make corrections to white balance,
exposure levels and then apply the calibration profile either as an
assigned icc profile (preferred) or as a DNG Profile. i1 products can do
both. Once all the Raw files are processed they should be assembled as
described for scanning if multiple shots have been employed.

Lenses

icro-NIKKOR

Providing you steer clear of wide-range zoom lenses you should be OK
for single frame reproduction. However, the specialist lenses such as the
55mm f2.8 Nikkor were specifically corrected to produce lowest distortion
at A4 reproduction scales. There is also the issue of working distance
which can be a problem; if a stand is used for the task it might require
considerable working height and you are likely to need mechanical
stabilisation to reduce flexing. We first wrote on this topic in 2003 and
the diagrams remain pertinent today, the laws of optics don't change
(see the Lockdown Locker resources). However, technology does change
and the in-built profile handling of Adobe Camera Raw (or DxO for that
matter) corrects any residual geometric distortions quite well. We would




The 24-70 f2.8 (left) has good distortion correction, the 24—-120mm f4 (right)
is only really suitable for holiday snaps where its versatility is a boon.

be very reluctant to use our 24-120mm f4 Nikkor for reproduction but
the 24-70mm 2.8 zoom we previously owned was actually quite good
on distortion. The bottom line to this is that most of today’s ‘professional
lenses’ will do a reasonable job if used within their limits.

One thing that technology has brought is the really high-resolution
camera chips delivering up to 50mp; that compares with the 6mp we
had in 2003 when first writing about fine art repro! An outcome of this
additional resolution is that Photoshop adjustments such as rotation,
transforms or geometric corrections are far less pixel-damaging. If, when
reproducing a heavy impasto image it is catching the light regardless of
what you do, it is possible to shoot at a glare free angle and then pull the
distortion back using the transform tool. Don't forget with an image that
has lots of impasto that the repro lighting should be biased towards a
top light so that shadows are cast down the image in the way a painting
would.

Calibration Aids

We have written extensively on this topic and resources are available
in the Lockdown Locker. It is, however, worth compiling an
up-to-date summary. If you are reproducing images professionally it
is reasonable that you should invest in the highest accuracy kit that is
available. This can be provided by a Macbeth SG target and an i1 Profiler
software for we can say (and demonstrate) that nothing is quite as good
when it comes to scanner and camera calibration. There is a hierarchy of
accuracy that starts with a grey card, runs through various ‘devices’ and
targets and ends up at the Macbeth SG in conjunction with i1 Profiler
Publish. This combination is near perfect, delivering errors in our tests of
1.22AEo0 in a scanner (Epson V750) and 1.6AEoo for a camera calibration
(most DSLRs). Both of these values are just above the detection threshold.
The profiling software will also produce bespoke icc printer profiles that

The X-rite Macbeth ColorChecker SG has no real parallel for calibration
purposes — here in use calibrating a scanner of an average error of just
1.2AEoo, the errors are superimposed but almost invisible to the eye.

can deliver printer accuracies of the same order (the best to date are
around 1.5AEo00) with gloss, lustre or proofing papers. Even this quality
can be exceeded if you employ a GMG RIP to print but that does move you
up quite a notch on the money stakes (north of £5,000 just for the RIP!)
however, it did produce errors of just 0.62AEoo0.

In summary the hierarchy of accuracy at the capture stage runs as follows:

Method Average AEoo

Test1 | Test2 | Test3

ACR Adjusted 39 3.8

Passport CC 35

ACR Calibrator 35 2.2

Spyder ColorCheckr 39

I1Profiler to SG 1.6 1.8

Ditto match 2109 1.2
Expo Disc 46

ACR to Macbeth CC24 2.5

X-Rite Passport 3.8
ACR Calibrator and Passport 2.2
DNG to Passport Checker 2 47

Passport 2 to SG 2.6

Most of the devices listed above have been reviewed in Imagemaker and
are made available in the Lockdown Locker.

Detailed Colour Correction and File Preparation

f a piece of your own art is being printed for sale then much of the above

has less relevance. It is matching the print exactly to the original and to
the satisfaction of the artist that is the great challenge. Metamerism is the
enemy at this stage for although we might be reproducing at accuracies
of less than 2AEoo the metameric errors can be much greater than this. In
detailed tests, conducted in 2006, we measured the actual oil pigments
being used by artist Penny Warden as we assisted her fine art printers who
had been experiencing problems matching the colours. The metamerism
values were high in comparison to the accuracies that the ink system was
capable of. The table below shows the pigment metamerism and the
metamerism of the reproduced tones in the print (as Lab values and not
using the methods we employ today).

Metamerism Index

Lab AE D65 to Tungsten
Colour Oil Pigment Epson K3
Orange 12.1 11.2
Orange red 16.0 15.2
Red 15.8 15.3
Deep red 8.4 5.0
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Fine Art Printing

More recently we looked at metameric index measurements on a range
of ink jet prints from the HIGAM series we employ for colour auditing. The
Colour Inconstancy Index for the Epson 4900 and Epson 7500 ink sets are
shown in the first column and generally the print errors are under 2AEoo
whereas the metamerism index ranges from 2AEoo up to 8Aoo - in other
words the error due to metamerism overwhelms the error due to printing!

One reason that this variability
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ST Colour Name @]l cll
from metamerism is important
is when an artist has used Printer 4900 7500
dlf_fer.ent plgments in their Yellow 344 36
painting to mix an apparently
identical colour which then [ Orange 3.72 3.68
scans differently due to the
metamerism of the scanner |Red 6.42 6.48
fluorescent tube. This is why this | Magenta 7.97 7.86
section is sub-headed ‘Detailed
Colour Correction’; when faced | Purple 4.59 491
with such challenges there is | g e 284 274
sometimes no option other
than masking the image and | Moderate Blue 2 1.62
applying selective  colour
adjustment  where  these Cyan >.08 457
anomalies crop up. It is quite | Turquoise 6.25 5.74
detailed work involving fine
adjustments and accurately BlueiGreen = 2
made Photoshop masks on Green 7.74 7.76
Colour Adjustment Layers. -
Lime 7.57 8.01
Assuming that all these issues | yellow green 6.6 6.85

are resolved to the limits of
the technology we are ready
to print!

Printing, Profiling and Colour Auditing

he icc profile is used to colour manage the output from a printer and

is an essential part of the workflow. As with calibration aids there is a
hierarchy of workflows and their overall accuracy. For icc profiles, starting
with the worst the list is as follows:

ACCURACY RANGE*

AEoo

WORKFLOW

Gloss (Pk) Matt FA
(Mk)
No Colour Management 6-16+ NR
OEM Profile from the Printer Driver 4-6
Generic Profile for a third-party paper 3-6
Bespoke profile for your paper and printer 1.6-4.0 2.8-5
Bespoke Profile with full audit and 1.6-3.0 2.8-4

adjustment

GMG Four-dimension profile build and calibration with iterations

Iteration 1 3.10 NR
Iteration 2 1.1 NR
Iteration 3 0.62 NR

*The values are typical across 20 years of testing

There are some basic rules that should be followed when attempting to
work at the higher levels of accuracy:

+ Always install accredited ink of OEM specification.

« Always start the session with a printed nozzle check.

« Always profile build and then print at’‘Maximum Quality’ settings
with an appropriate (and recorded) media setting with bi-lateral
(high-speed) printing turned off and an appropriate platten
gap. Ensure that settings such as Black Point Compensation and
Rendering Intent are obeyed and are consistent with the audit
printing workflow.

- Ensure that the correct profile is used (and double check
sometimes the settings are not sticky!). We have had clients use
say Epson 3800 profiles left on their computer after they have
installed their new Epson 3880. It does not end well!

: ’@n gemaker

« Audit your output by measurement if you can; it is the only way
to check for certain that all is well.

« Examine every square inch of the print with care before signing
and curating it. Destroy any substandard prints.

- Retain at least one print as a reference proof and store it in a cool
dry dark space.

« If you are printing on demand either re-audit the output
to confirm calibration is sticking or at least make a careful
comparison with the retained proof print.

«  Beware of high temperature and humidity fluctuations and that
profiling and auditing are carried out in typical/similar conditions.
At Imagemaker we lost control of our proofing accuracy during
a spectacular heat wave some years ago, something that also
happened to our offset press printer at the same time (they had
to bring in air conditioning to their proofing room to get back on
track).

Auditing

The only way to be sure that your printer is working correctly (and
consistently) is to measure the output and compare it against a standard.
This is built in to i1Profiler which can use a number of European, Japanese
and US standards intended for the contract proofing market. They serve
admirably for most other purposes although at Imagemaker we have
created our own test target which reflects an attempt to reproduce
very high saturation colours which are occasionally found from acrylic
pigments. One advantage of this method is that the test patch set can be
tagged onto a print (especially when printing from a roll) and then audit
the result before either trimming the target off or leaving it on for a proof.

In the example shown we were auditing the front cover proof for the
June-July issue of Imagemaker. The audit process was completed in
1mO05s and delivered the assurance that the print was spot on. If required,
the verification label can be printed to our label printer and attached to
the proof. Such verification can be a boon when a client is arguing about
the reproduction, once you can explain that the proof is almost perfect
the discussion can move on.

Paper Choice

ow the paper has to be chosen. Sometimes the author will specify

the paper they would prefer and if so, the decision is made!
Oftentimes the printer can make suggestions and have samples available
for test printing so that the artist can choose. Other times the artist may
be looking for the printer to provide advice on paper choice. As the expert
you should be able to demonstrate both knowledge and experience on
papers and their properties. There is one golden rule - gloss, lustre and
semi-matt finishes (including the barytas, let’s call them GLSBs) produce
prints that are brighter, have higher colour depth and more pop all round.
If you make the mistake of showing your client a GLSB version and a matt
art finish they will want the high gamut colours on a matt paper and that
is never going to happen - all you are doing is setting up to fail! You have
to educate your clients at the start of the process (and that might include
the option to gloss varnish a matt paper).

We could devote the remainder of the magazine to paper choice which
is why we have made a variety of resources available in the Lockdown
Locker. For fine-art printing the first option is a zero OBA, matt finish,
archival grade, lignin free media with a weight of at least 250gsm.
Preferably it should be from a recognised mill (because you are going
to have to specify where it came from on your certificate of authority).
Surface finish is optional but a good rule of thumb is to go for a smooth
finish if the image thrives on detail, a watercolour rough finish if you are
reproducing a painting (water colour or pastel). If the subject is purely
photographic (whatever that means!) then you might look at a GLSB
but once again avoid OBAs if at all possible. Our own go to media would
be the new Canson Baryta Photographique 2 (reviewed in this issue)
or Permalet Fibre-Base Gold Silk 315 as they are both OBA free neutral
finishes with spectacular accuracy and deep, rich colours.

One of the issues with specifying a paper is the number that we have
to choose from. There are many hundreds and frequently a media is a
re-boxed version from the same source. One thing we always warn against
is‘being seduced by the example print’ By this we mean choosing a paper
on the basis of a print you have seen and admired - it might not perform
so admirably on your particular image! The makes and distributors of




paper supply medley boxes of papers for particular purposes which are
a valuable source of test samples. You could do worse than buying a box
and printing the same image on every sheet to show to a client or assist
in your own decisions. One useful piece of advice is that if you can cope
with roll material do so; it is far less hassle than feeding sheets which can
sometimes get a little curly with storage! The best place to look at test
packs is On-line Paper (https://www.on-linepaper.co.uk/test-packs-and-
other-services/test-and-
sample-packs) because
they supply a wide range
of papers from many mills
and distributors. Initially

Canson Discovery Pack Contents

The Canson® Infinity Discovery Pack Fine Art Photo include 10 sheets :

we had ambitions to list

the packs but it rapidly Platine Fibre Rag 310gsm

100% Rag, ultra smooth glossy, pure white, without OBAs.

spiralled out of control! Baryta Photographique 310gsm

True Baryta paper developed for inkjet, Pure white(2010 TIPA Award)

By way of example we have Baryta Prestige 340 gsm

pulled out the Canson

It'is a smooth Baryta Gloss paper which evokes the look and aesthetic feel of traditional darkroom papers
(2017 TIPA Award).

offering for fine art: Photo HighGloss Premium RC 315gsm

alpha cellulose resin coated, ultra white and ultra smooth with the highest gloss level of the RC paper market.

PhotoGloss Premium RC 270gsm

alpha cellulose resin coated, glossy, ultra white.

We could have shown [ ppotoSatin Premium RC 270gsm

Resin coated Satin, Extra white.

you similar offerings from

Awagami, Canson, Epson, | PhotoLustre Premium RC 310gsm

Exceptional strength, Excellent true lustre surface, Extra-white, High opacity, (2015 TIPA Award)

Fotospeed, Hahnemdiihle,

lford, Innova, Olmec, Rag Photographique 310gsm

100% rag — ultra smooth, ultra white paper, without OBAs.

Permalet or St Cuthbert's | Rag Photographique 210gsm

100% rag — ultra smooth, ultra white paper, without OBAs.

Mill. If that lot can't keep

you out of mischief during Rag Photographique Duo 220gsm

100% rag, ultra smooth, double-side coated, ultra white paper, without OBAs.

lockdown nothing will!

One thing we can say

with some certainty is The Canson® Infinity Discovery Pack Fine

Art include 9 sheets :

that most papers perform | printMaKing 310gsm

1009 rag, Mould-Made, smooth, pure white paper, without 0BAs

within the same sort of

error band when they Velin Museum Rag 315gsm and 250gsm

100% rag, Mould-Made, smooth, pure white paper, without OBAS.

have been well profiled. | Egition Etching Rag 310gsm

100% rag, smooth, ultra white paper, without OBAs.

If you use manufacturers

or third-party profiles and | Rag Photographique 310gsm and 210gsm

100% rag — ultra smooth, ultra white paper, without OBAs.

the match is poor you [ gao photographique Duo 220gsm

100% rag, ultra smooth, double-side coated, ultra white paper, without OBAs.

may see a deterioration
in performance (and

Aquarelle Rag 310gsm and 240gsm

100% rag, Mould-Made, smooth, pure white paper, without 0BAs.

conversely if the match is
good so will be the result!)
but that is why having your own profiling kit is by far the best solution.

Decision on the Edition Size

his refers to both the number off and, physical size of the print

and the size of the printed area - all are normally referred to in the
certificate of authenticity which should accompany a print sale. The
number of prints that you elect to issue is always a tricky guestimate at
best but once the edition is launched it is fixed, you cannot decide ‘that
sold well’and bung more into the system for that devalues what you have
already sold and is rightly regarded as fraud. You may of course declare an
open edition, in which case anything goes and your buyer might respond
accordingly in their evaluation of you edition. Some artists start at a lower
‘entry’ price and gradually increase the selling price as the edition sells
out. In terms of numbers 850 is consider by some to be a fair limit for an
edition but many artists sell very small editions (as few as three) at high
value. All these numbers are hypothetical for a beginner in the market but
you might reasonably ask yourself how much you want to make on the
venture. If for example you sell 10 prints at £200 to make £2,000 does that
reflect the work you have put into producing the edition and marketing
it? For a beginner an edition of 25 seems about right, remember that if
you sold that many at a fair price you would be in profit and you might
already be on the way to building a following. One advantage of printing
on demand for a limited edition is that you can print a small number and
test the market, if the prints don't sell you can always withdraw the final
prints by simply not making them.

When it comes to the physical size of the print, bigger is better. If these are
high-quality, high-value images they are likely to be displayed and prints
have a habit of ‘shrinking’when set on a wall. Also, a large print has greater
presence and perceived value without too much additional cost to the
producer, the raw materials should be a fraction of the correct selling
price. The same psychology applies to the border of the print, especially if
itis to be sold unframed - it looks more imposing with a four-inch border.
Framing is expensive especially if it is archival grade (and it should be!)

and there is a chance that the buyer would wish to match the frame to
other prints they own or to the room décor. If you already have a framing
business tagged on to your photography then you have the opportunity
to provide both frame and print as a bespoke pair of course.

Ultimately the size of the print will depend upon the size of your printer.
Many would regard a 24-inch printer as the entry point if you are serious
about your work but if you are going larger you have to consider the risks
to your return on investment. Conversely if you go too small you are going
to have to re-invest if things go well — a larger printer can always be set up
with a smaller roll of paper or sheet fed media.

Certificates of Authenticity

hese are common in the fine art print world and solutions are available
from Hahnemihle which include paper to print the certificate
(watermarked), along with pairs of holograms uniquely numbered, one
for the print and one for the certificate. The certificate should contain at
least the following information:
The title of the piece
The name of the author
The signature of the author
The size of the edition
The number of the print within that edition
The physical size of the paper and its type
The size of the printed area
The date
The ink media used

Hahnemiihle also provide a service for registering your artwork with
them at
https://www.hahnemuehle.com/en/digital-fineart/my-art-registry.html.
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Profile Building

lcc profiles are the DNA of colour management -
they control what happens to colour as it moves
around your system: replicating, reproducing
and creating colour for either display or printing.
For something so powerful they are, at heart,
relatively simple, existing as simple text files
which describe how a colour should be set up for
display or printing so that it looks correct. Like
DNA, the profile is unique to the ‘system’ that
it was created for. So, for example, a profile for
the Imagemaker office Epson 4900 is specific to
that machine, ink-set, paper and all the settings
that go towards creating a print. The profiles are
not, however, unique to our operating system
- a profile can be made on a PC and then used
on a Mac and vice versa. If we sold the 4900 to
somebody, we could transfer all the profiles and
it would perform in an identical manner in its
new home.

There are a relatively small number of profile-
making applications and the two most common
ones in photography are those from X-Rite (the
i1 systems) and Datacolor (the Spyder systems);
http://www.color.org/profilingtools.xalter lists
the main players). They all work in the same
manner, you print out a set of coloured patches
from a defined source, then measure the
patches with a spectrophotometer and then the
software makes a profile which is automatically
installed on the host computer in a special
location reserved for colour profiles.

The profile build takes minutes (rather than
hours) to complete and the measurements can
be made either by the operator dragging the
spectro across the sheet in an ordered fashion
or with fully hands-off, automatic measuring
devices. The automatic devices work a little bit
like a laminator, you feed in the sheet and it does
the rest! Although the process looks daunting it
is actually very simple and on our iTPublisher
version we normally leave all the settings at
default although we do have to specify the
number of patches to use and the sheet size we
are to print to.

The question of how many of patches to use is
a tricky one to answer. We standardise on 727
because it is one of the defaults and fits onto a
single A3 sheet of paper. If only a single sheet
of A4 is available (and for some experimental
mill prototypes we consult on there are only
two sheets! No pressure there then!), we drop
back to 400 patches. The i1 targets will actually
go up to 6,000 patches but any experienced
profile builder will tell you that sometimes
numbers that high actually make an inferior
profile - they certainly take for ever to measure!
We also scramble the patches to smooth out
any variations across the sheet so that all the
cyans, for example, are not crowded together.
We standardise on default D50 as the illuminant
and strongly recommend that you do so too.

Once the profile is calculated and stored it is
instantly available in Photoshop for selection
from the drop-down menu. The profile should
be checked for continuity in the 3-D model
you are shown [4] - if there are any lumps
bumps or holes you need to begin again with
the measurement (not the target printing). The
colour can be checked with the simpler systems
by printing the Macbeth Target [5] and then
laying the control over it. The control has holes
in it so that you can compare the print against
the reference. This is a subjective measure
which we at Imagemaker will having nothing
to do with (but is still better than nothing). It
is possible to take the profile through a second
iteration in which additional patches are printed,
again this is something we never do, we aim to
get all profiles close to high accuracy first time.
There is a routine for dealing with OBA activity
and its influence on the profile build but this too
is a little subjective as the user has to visually
determine the best match.

Note that the above is but a small portion
of the profile building facilities available from
the higher-end i1 systems which also include
multiple Pantones as extra channels (and
printing plates at the printing house) but are of
no relevance to the subject of this feature, the
printer driver itself takes care of the additional
inks in your printer.




Auditing Your Print Output

S8 1Profir X

This is the audit from i1 Publisher
on the Fogra/Ugra test patches.
The data on the left of the screen
can be printed out to an adhesive
label and attached to the validated
proof. A contract proof must have
the label attached. For the curious

- the error data for every patch is
=%%%=%%%%%%%%%%==...= [ also available — useful for value
[ Jalealvalzal 4 | V7] | | Jealvala) a7 Jjudgements if a print is only just

i failing; you can see where the

problem lies.

# gra/Fogra Media Wedge CMYK V3 AED.

ayout

PP WA

i1Profiler Verification Print

Goneral Resuts

I i1Profiler Verification Print

Reference FooRAseL it General Results

Report summary Passed. 4/15/2020 --- 04:54 PM

Patch set Fogra Media Wedge CMYK V3 AED
Reference FOGRA39L.mxf
Test Tolerance I Measured
Average AE, all patches 3 1.01
AE, Paper White 3 0.71
Average AE, Outer Gamut 4 0.87
Average AE of the lowest 90% - 0.91
Average AE of the highest 10% — 1.99
Maximum AE, all patches 6 231
Maximum AE of the lowest 90% - 1.83
Maximum AE, Primaries 5 1.32
Average AH, colored gray patches 15 0.56
Maximum AH, Primaries 2.5 1.74

The built-in audit process for i1Profiler, GMG
RIP and EFI Fiery RIP are all based
on standards produced
for offset printing
using various CMYK
profiles. A print
meeting the standard
is by definition of very
high quality, far higher
than a wet chemistry
lab can achieve for
example. However, it
does suffer from having
an in-built limit to CMYK
gamuts which are smaller
than those achieved by
quality inkjet printers. This

is particularly true of the
maximum black which is
limited by the CMYK profile to
around 2.2 whereas the inkjet
can achieve value of 2.6 in some
circumstances. A proof with a
maximum black of 2.6 would
actually fail as the measured error
would be outside the specification.
these limitations the offset press proofing standards do
represent high quality it is just that the values might need
interpretation and will not print a file with the magic word
PASS on them!

LR




Fine Art Printing

Signing and Stamping

print should always be signed. The act of signing broadcasts that the

author has made the print, is happy with its quality and proud of it!
It is problematic if you have an ugly signature and you might consider
developing a signature specially for prints and certificates — just make
sure it is consistent and repeatable. It also gets around the problem of
somebody scanning you signature from artwork and using it fraudulently
- the reason why the signature you sign your cheques with should be
different!

In terms of what to use for a signature, a soft pencil is best for a matt art
paper but might not work on a gloss media. We have tried all sorts of
stunts including using ink jet ink in a fountain pen or with a dip pen. The
Sakura Pigma Micron Fineliners do a serviceable job, although they lack
the character of a nibbed pen.

One way around issues with ink signatures is to use a stamp and
impress the print with both your signature and logo. They also look very
sophisticated and certainly cannot be erased!

The Lockdown Locker contains a multi-page discussion on this rather
complicated topic.

Keeping Records and Print on Demand

t is important to keep track of the prints you have issued and their

numbers especially if you are printing on demand. Printing on demand
brings its own set of issues in that you have to ensure that the latest
print is a perfect match to those that have already been issued. It is one
good reason to print the entire edition in one run. The very least that
you should do is keep a reference proof print (usually signed as an AP or
artist’s proof) and a set of notes detailing the printing parameters used
(and keep the notes in a hard-backed book not on a scrap of paper!).
There is a danger that a late-printed product will be on a different batch
of paper, almost certainly with a different batch of cartridges and, in the
worst case scenario, you may no longer have the printer available (they do
fail!). Again, this is a reason to print the edition at one sitting and perhaps
keep the edition size lower rather than higher so that the tactic is not
too expensive. It should be obvious that you should store the master file
securely and have secure back-ups as well - regard this as your pension
fund! And this goes for your icc profile as well — you could lose it with a
hard drive failure or you might even forget to make a note of which profile
you employed.

If you are printing on demand each session should be preceded with a
nozzle check and auditing of the output if there is a hint of change. To put
that in perspective the GMG RIP produces a nozzle check with each print
automatically and requires recalibration on an almost daily basis - this is
a cost of high-accuracy printing.

Cherish the Print

Look after your finished prints, handle them with clean cotton gloves
and do not allow artist-clients or potential purchasers to handle them
(at least not without gloves and supervision!). Your prints are a precious
artefact, if you do not show them the utmost respect you can hardly ask
your purchasers to do so! It should not need saying but do not allow
drinks or any other liquids anywhere near your prints or print storage area
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- accidents do happen | have plenty of horror stories about the demise
of valuable artwork!

RIPs

Raster Image Processor or RIP is a way of sending a file to print

without the intervention of Photoshop or Lightroom - they are
stand alone. They have several advantages and some disadvantages.
They are primarily intended for cmyk workflows that is to mimic on-press
performance or to send a file to press to be separated into the four plates
of cmyk. Some, such as the GMG, circumvent the print driver altogether
and impose their own rosette dot making to better mimic real press
conditions. Although RIPs such as the GMG are capable of superlative
colour performance they sometimes do not perform as well with detail
as a well-profiled printer driven from Photoshop. An Epson driver has
no need to mimic a rosette pattern for example and can lay down ink
in the most accurate way possible rather than compromising to indulge
in mimicry. The advantage of a RIP is frequently because they can nest
images, that it sit waiting for the folder to fill with sufficient images and
then start printing only when enough are available and they have been
arranged in an optimum manner of the roll width available. If that is
what you require then Mirage is the best solution for an Epson or Canon
printer as it employs the optimised OEM print driver but is very simple
to use requiring only limited skills (unlike Photoshop which has many
traps awaiting the unwary!). Mirage will also prepare a file for canvas
wrap around, adding canvas and colour outside the image area. A review
(admittedly old) is available in the Lockdown Locker.

There are many RIPS available including some open source products.




The Wave Form
LIMITED EDITION PRINT
by

Charles Farnetl ares

EF

Case Study

ven with the best controlled proofing and curating, a print for a

limited-edition run is always fraught with pitfalls! We chose to prepare
first-offs for one of Imagemaker’s contributors, Charles Farnell and retain
all samples and data. The image fitted our idea of a suitable subject for a
limited edition print - it is simple, unusual and attractive ie marketable!

The starting image was a Raw file from an Olympus E-M1X with the M49-
150mm f2.8 lens. The exposure conditions were 60mm zoom length, 0.5s, f
22 and an ISO of 64. The shot was taken during Storm Daniel on the Wirral
waterfront. The original Raw file was 5,184 x 3,888 pixels in M%: format. This
was cropped to 4,656 x 3,253 pixels, along with some burning, dodging
and colour adjustment to prepare the file.

Our starting point was to assess the capabilities of the file in terms of print
size, something you often have to do, more especially when somebody
has asked for a wall-print from their iPhone masterpiece (yes they do!).This
computed as follows:

File Dimensions Printed Area

W px h px Resolution Width in Height in
300ppi 15.5 10.8
4,656 3,253 250ppi 18.6 13.0
200ppi 233 16.3

So, we worked out that an inked area of 18.6 x 13 inches world sit nicely
on an A2 sheet with a generous border, using 250ppi. The first task was
to create a Photoshop file at the required 250ppi resolution at A2 size
(594mm x 420mm). We used the File>Place Embedded command to
place the original as a Smart Object. We always use a Smart Object in case
we have to tweak the size and so can amend non-destructively. It also
allows for the downstream option of adding a Smart Filter if any colour
adjustments are called for after proofing (prescient as it turned out!).

We eyeballed the placement of the file as shown in the screen grab and
then trialled the titling and fonts. The required text consisted of the print
title, the author, and the strap line ‘Limited Edition Print’ At this stage we
also decided that a black key line was required and one was introduced on
a new layer above the image. The type was set and optically adjusted with
several variants of fonts until we arrived at the final typography as shown
in the screen grab. At this stage you should always check (and then double
check) your spelling - you do not want to roll out a hundred pounds worth
of prints with a typo!

The W&Ve FOI'I'H Times New Roman 30 on 36pt

LIMITED EDITION PRINT Engravers MT Regular 11 on 20pt

by Myriad Pro Regular 15 on 27pt

Charles Farnell sres

Caflisch Script Pro 28pt + lower case Small Caps on Arps

All text set in 40% Grey (5e5e5e Hex)

In order to create an audited proof we extended the canvas from 24 to 28
inches (it's called a slug) and placed the colour control patches. The media
chosen was Epson Fine Art Smooth Cotton Natural from a roll. For this we
had a profile already archived from our Imagemaker test in January 2019
complete with audit - so we knew what to expect. A nozzle check was
printed before we commenced with the proof print.
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Iine Art Printing

A
Measurement Conditions Measured illuminants
Mo M M2 Get Ambient-1 | @ Load...
Observer (Mot loaded)
®2deg. (O 10deg.
Get Ambient-2 | @ Load...
ClIl/SMI formula: | CIEDE2000 v (Not loaded)
Wave Q000 QI 0.00 Paper
Ref. | DeltaE*
T Reference (L*a*b*) Sample (L*a*b*) [;MI]
D65 v||  8692/-0747477 | 9809/-054s242 | Ta4
A v 87.12/1.05/ 467 [ esi9s0zss237 | 712
Test (CIE15 corrected)
illuminant | [ e700/-002/4 | 153
a:135 k050 MI (CIE15)
GetRef. @@ 0.99 Get Sample | @
T Mi (HunterlLab) oL
Cll: Color Inconstancy Index. Recommended ref. illum.: DE5. Cll ref. illum.: | D65 ~
The first print was proofed and it audited within the expected tolerances. SMI: Special Metamerism Index: Valid if there is a match (DeltaE* near or =0) for one illuminant.
However, the underlying cream of t!']e paper was deprfessmg the cooIr)es; s TR e T =
of the water surface making the visual rendering a little muddy. This is
not a flaw in the printing but a real world expression of the adage ‘the -
ABOVE:

colormetrically accurate proof might not be the most pleasing print!" We e
noted that the original file has a water plume (the main feature of the
composition after all) that is nearly neutral with colormetric values of 88%
L, 0 a value and +1 b value. The profile was shifting this further towards
the cream of the paper at 87% L but -1 a and +5 b value.

Some of the stages
involved in the
preparation of the limited-
edition print. Having a
spectrophotometer for
profiling also enables the
user to interrogate the
print numerically and
make judgements. Here
the wave print value is
compared with the colour
of the paper background.
LEFT:

Printing from Photoshop
requires great care to
ensure that the correct
settings are employed
for every print to ensure
& the correct colours and
consistency.

W s

After some consideration we added a Smart Filter with Raw adjustment
and cooled the image by -8 points on the Color Temperature scale. There
is no Lab readout in the Raw filter dialogue and the Smart Filter was useful
because we could re-open it and increase the setting to -15 points non-
destructively to give a calculated shift towards blue of 5 points, to take the
plume to -1 a and -3 b values.

Although these differences are quite small (we have occasionally seen
errors of this magnitude in straight prints!) they have a profound effect
on the emotional feel of the print. Although the adjusted print is cooler, it
looks far more alive and the somewhat muddy look of the Mersey is not
necessarily the feel you want to portray (this was not the first time we have
run in to trouble with cream papers combined with River Mersey water!).
This begs the question as to why we spend so long profiling and auditing
the printer/paper if we then throw an optical correction at it with a slice
of guesswork. Well, it is all about control. If we know that the printer is
outputting correctly (and exactly the same as before) we can print with

confidence and who is to say that the image might not be shifted to

another media altogether at the request of the artist — then all we do is

delete or tweak the Smart Filter and we are back to our secure baseline.
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It is also worth calculating the cost of all this proofing. We made four
proof prints which, with audit bars, ran to 28-inch runs on 17-inch paper.
Including the nozzle checks (at 77p for paper, each time) this totals £28.40 ln Summary

for raw materials alone. Added to the time to produce and measure the

audits we are well over £100 before an edition print has been produced t would be unwise to bet your house on making and selling
- think about that when you are calculating what to charge. Wastage also limited edition prints. However, if you follow Christy Lee
needs to be considered, one of our proofs had a white mark caused by Roger’s lead and produce one for charitable purposes who
a shard of paper falling onto the media surface before printing. In this knows what might happen - good things do sometimes
instance it made no difference, but such a print could not be sold in an come to people who do good deeds. In any event the ability
edition and would have to be scrapped. to produce superlative quality prints is a useful life-skill for

a photographer! One sure thing about earning a living from
prints is that it is not the quality of your images (we make the
starting assumption that they are reasonable quality) that will
govern success, it is the quality of your marketing. This is not
true of printing for other people where superlative quality
should always bring clients to your door. That said we have
seen some really dodgy prints hung up far sale, including
local scenes hacked out on an A4 printer with hooky ink onto
photocopy paper!

This beautiful image by Carol
Tipping Fres was made in Corel
Painter and could be output as a
fine art print without any other

interventions.
Lockdown Locker Contents
Subject Area File Name Date Contents
Repro FA Repro 2003 2003 Lens selection and lighting
FA ReproCompilation Articles | May 08 Compilation article across a range of repro challenges and solutions
Camera Calibration 2006 Advanced camera calibration
Calibration X-Rite Passport March 10 Using X-Rite Passport for DNG Creation
Macbeth at 40 Apr 16 Extensive discussion of all calibration tools available
Paper White March 12 A discussion on paper white, measurement and OBAs
Paper Paper Testing March 10 Aspects of testing printer papers
Selecting a paper 2011 From Epson Print Academy syllabus
Bartyta Roundup2103 Nov 13 Compilation of all baryta paper data
GMG RIP March 10 The high accuracy GMG Proofing RIP
RIPS Mirage Review March 11 Easy to use Epson RIP
EFI Fiery RIP May 13 The EFI RIP including audit and contact proofing ability
Proofing Proofing 2008 Sep 08 All aspects of proofing
Mono Printing | ABWRefined Sep 12 Epson ABW monochrome driver
S thestateoftheartprinting May 20 An update on the status of inkjet printing
Making your mark Jul 15 Signing and embossing of LE Prints
visit: https://thesocieties.net/lockdown-locker/

o &
w
109 July 20




	Editorial
	News
	Things to do while you're home
	Claire-Marie Glennon on budgetting
	LinkedIn by Jeff Brown
	Elincrom ELC 125 & 500
	Quality Time In Santorini – Stuart Wood
	Diana Buzoianu – Associateship Panel, Landscape
	Angela Adams talks to Peter Neill
	Mike McNamee – State-of-the-art colour printing
	Tom Lee in The Galapagos
	McGillicuddy
	Panikos Hajistilly– Fellowship
	Rashida Keenan – Associateship Panel
	Terry Donnelly – Wiltshire Air Ambulance
	Books
	McNamee on Typography
	CorelDRAW 2020
	Montizambert 64
	Competitions January 2020
	Competition February 2020
	Rolling with the Little Dog

